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Chapter 1: Projects, Processes, and
Priorities

6-Stage Process for Every Project

1. Define — What are we doing, and why are we doing it?

2. Plan — How are we doing it? When, where, and with what resources?
3. Implement — Doing the project.

4. Complete — Specific deliverable.

5. Evaluate — What worked, and what could we do differently next time?

6. Celebrate — Do something to reward yourself and/or team.

Project vs. Process:

6 Characteristics that Define a Project

It is something that has never been done before.

It ends with a specific accomplishment or achievement.
It has a beginning, an end, and a completion date.
Resources (schedule, time, money, etc.) are limited.

Other people are involved on an ad hoc basis.

2 A

Phases and activities are sequenced, with milestones and event markers to
show progress.
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Project vs. Process

Projects can be comprised of processes, _ Six Stage Project Process: |
such as this six-stage process. For — Define J
example, this process can be used to — Plan }
establish the steps in building a — _ Impliment
warehouse, or for setting up an accounting ‘ Monitor }—{ Adjust ‘
system. How would you explain the ——  Complete |
project/process differences to one of your — Evaluate J

——  Celebrate |

team members?

The Triple Constraints

Time/schedule, quality/scope, and budget/resource are fully interrelated and
must be ranked in order of the driving, middle, and weakest constraint according
to the goals and priorities of the project and/or the goals of the stakeholder(s).
Any adjustment to one will affect the others. In many cases, a project manager
may be quick to change one aspect of the project by adding scope to a project or
agree to a budget cut without considering the consequences of that change to
the other constraints. Any adjustments to time, quality, or budget will lead to
future project issues. By ranking these constraints and considering all of them
before making changes to the project, you ensure the highest chance of project
success and completion.

Driving Constraint: Most Important and least
flexible. Failure to accomplish the driver and

the project is a failure. skt

Time
Middle Constraint: Less important than the FAGgRN R eI
driving constraint but more important than the Sime/Sitiediln
weakest constraint. Budget

Weakest Constraint: Most flexible and or

least important constraint. If a major change needs to take place within a project,
start with the weakest constraint for the least amount of project impact.
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Action: Ranking a Project

Choose a current project you are working on.
Determine the time, quality and budget you have for that project
a. How much time is required?
b. What is the desired outcome or quality?

N =

c. How much will this cost you in money or man-hours?

Rank the constraints in order of priority
Put the project onto your calendar

B w

Action: Rank yourself

1. Rank what’s most important to you by nature
a. Time
b. Quality
c. Budget
2. Ask yourself as you face each task throughout your day what is most
important, time, quality, or budget. This will also help you with prioritizing.

The Consulting Phase
Begin with finding out what is most important to your stakeholders.

Good Questions to Ask:
¢ |s the deadline on this project a target date or an actual deadline?

e Which is more important, staying under budget or delivering the highest
quality or completing the project on time?

e |f we have to cut time from this project, either the quality will go down, or
the budget will go up, what is your preference?

How can you use WAG (Wildly Aimed Guess) or SWAG (Scientific Wildly Aimed
Guess) as estimates if you've never completed this particular project?




Chapter 2: Pro Tips, Technigues, and Tools

A Project Manager’s Success Kit
The Three T's
Give an example for each of the following:

1. Tips

2. Techniques

3. Tools

Why is it important to use all three?

Three Project Management Tools

1. Project Work Breakdown Structure (WBS)

New Computer

System
1
1 1 1 1 1
Define Plan Implement AdjustMonitor Complete
1.1 12 13 1.4 1.3

o B

Create Preliminary Project Kickoff Andit Procurement
Scope Statement Meeting 151
1.2 131

Notes:
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2. Gantt Charts

Home | nsert  Pagelayout’ Formulss  Data  Review View > P = &
_‘3 A Cut calibri o ca s wmwmfE - Bweprnm Gereral : Hﬁ ﬁ % '—; ~'-';. ':!: ;:: aSum - }-r Iﬁ
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Diagonal Lines through schedule shows percentage of project completion:

1/21/2015 1/26/2015 1/31/2015

'T.......

3. PERT Charts (Program Evaluation and Review Techniques)

] |
. L=
T - e ] A
[ e amy vy (]

4, Time Estimates
e Time Optimistic
e Time Pessimistic
e Time Most Likely

5. Critical Path Method
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Planning Tools: Mind Mapping

life/executive coach

meditation
joumal Spiritualit
youth ministry
articles
time i
grammar : books O wrie
coaching Giving Back
interpreter &
women's center ., volunteer
reading class
Health _

% Lifelong Leamning Career
PhD g

Utilize Your Right Brain and Your Left Brain

5 Minutes Defining Through Brainstorming

5 Minutes Putting Ideas into a Linear Calendar

5 Minutes Adding Steps to a Time Schedule

Use Software or Paper to Track ldeas
What's Working, What's Not Working?

Key Questions

Planning Tool Software:

Project by Microsoft

MindMapper by SimTech
ConceptDraw MindMap (and Project)
MindJet Mind Manager

www.MindMappingSoftwareBlog.com

Bonus To-Do Sheets and Templates

©2016 All Rights Reserved

client list

Home .

Marketing broker
speaker bureaus

book
articles

hire asst
Organization a new office configuration

Notonety .

PC Anywhere
consulting

Variet -
Y curriculum development

time
shelves/books
network
tranquility

exercise 2x
food combining
bone density
lower%body fat



http://www.mindmappingsoftwareblog.com/

To—-Do

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.




Current Projects & Priorities

Where Does It Go &

Current Projects & Priorities
Rank Goal Due Date st LR Slarled Rank Goal Due Date
- ‘ j - D O I
|
paomys | High Priority — Now — Today eonys | PriOtity — Planned — Calendar - This week
euonys | Med Priority — Schedule Next 2-Weeks ronys | LOW Urgency — Next 4-Weeks
enonvs | Emails — Phone Calls - Voicemails eronys | New ldeas — Other
Home Store
Priony$

Interruptions




Chapter 3: Using Microsoft Excel to
Connect People and Projects

Using Excel in the Field of Project Management:
Browse templates to get an idea of the scope of possibilities.

1. File
2. New

Book1 - Excel

3. Type in “Project New

Management”

Search for online templates ye

Suggested searches: Business  Personal Industry  Small Business  Calculator ~ Finance - Accounting  Lists

Prioritize the priorities:
which of your priority items
are the top priority? Estimate how much time each would take to accomplish, and
schedule them.

FEATURED PERSONAL

Designing a Spreadsheet

Mind map the content, then sketch the layout.

Agenda

Agenda Topic Blutb
Research
. Direct Mail
Blurb Date Materials Media Web Ads
Refreshments Logistics Advertising print Ads
Refreshments Location Room Setup Demographic
— Travel - Frequency
Room Setup . Cost BEOs .
Seminar Seminar
) Topic
BEOs Advertising Name N 2R \ Date
Organization )
. . 9 General Info Time
Time Materials Address Attendees Cost
Emai Location
Research Travel Phone

Each main topic is a separate workbook or sheet. Branches off of topics
are column headings. One of the branches is the variable by which to
divide sheets.

Hot Tip: Design your spreadsheets to grow downward. Also, remember you can
only sort and filter vertically, so put the item you would likely want to manipulate
into the rows.
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Smart Shortcut: Switch the rows and columns of a spreadsheet by transposing.

1. Copy the data to be transposed (without merged title cells)

First Quarter Sales

2. Click the target location o T O e
January February March Total Sales

|

I
: : : | California $9,700.00  $6,887.00  $7,954.00  $24,641.00|
3. Right Click > Paste Special > ! Florida $577400 $1691200  $634000  $29,035.00]
Transpose | Georgia $4,71200  $5330.00  $1,990.00  $12,032.00!
|_Indiana__ $9,957.00  $377800 _ $555500 _ $19,290.00]

4, Delete the old rows
. . . California Florida Georgia Indiana

If the formatting is not right, use $9,700.00  $577400  $4,712.00 $9,957.00
: : $6,887.00 $16,912.00  $5,330.00 $3,778.00
Paste Special again and choose $7,954.00  $6,349.00  $1,990.00 $5,555.00
Formats or . . . TN $24,541.00 $29,035.00 $12,032.00  $19,290.00

Use the Format Painter

1. Click a cell or range of cells that have the desired format

2. Click the paintbrush icon

3. Click and drag the paintbrush over the area you want to paste the format

4. Double click the format painter to paste to more than one location

Data Entry
1. Input Data: Click a cell > Type the information > Leave the cell

2. Edit Data: Double click the cell or hit F2 to put your cursor into the cell or click
the cell and edit on the Status Bar

3. Replace Data: Type over the current date > Leave the cell

AutoFill D
Excel can fill a series of numbers or dates; it knows the months, Sunday
days of the week, and their abbreviations. It copies and learns ' *
patterns; you can even create custom lists. 1

1. Type the first item in the series in a cell

2. Click the square in the bottom right corner of the cell, and drag to fill
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3. Click the icon that appears at the bottom right when you release the
Auto-Fill Handle to change fill options
Format as Table

On the Home ribbon, Format as Table automates alternate row shading, freeze
panes, the filter, and adding a total row. Tab from the last data cell to add rows.

H ©- | @ @& m s ExcelPM - Excel TABLE TOOLS
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER DESIGN
Table Name: Summarize with PivatTable — Properties | Header Row First Column /| Filter Button
Tablel B+l Remove Duplicates D-) Open in Browser | [v| Total Row Last Column E E
= . = Insert | Export Refresh . —
‘D Resize Table | g= Convert to Range Slicer o o Unlink | Banded Rows Banded Columns
Properties Toals External Table Data Table Style Options Table Styles
122 - fr | sty
First Name ~ | Last Mame ~ | Department ~ | Job Title - | Salary ~ | Perf Rating ~ | Mgt Level ~ | Training Hours | ~| LMS -
19 | James Parker Sales Product Management $  48,000.00 2 4 56 TCR
20 |Harold Raobbins Section Manager Circulation Manager $  38500.00 5 3 24 TCR
21 |Susan Sarandon Section Manager Dir. of Shipping $ 55000.00 1 3 48 TCR
22 | Laurent Yves Saint Section Manager Dir. of Training $ 4500000 2 3 36| Start7 |
23 | Total $1,140,500.00 1.400680107 1.228571429 547 21)
Sort

1. Click a single cell in the column you want to sort by
2. On the Home or Data Ribbon click Sort A-Z or Z-A

3. Use the Custom Sort for a multi-level sort

Advanced Filter

4 |[INCO Manager  Sharon ‘Tanner 555 Ocean  Anchorage | AK 45637 Retailer  $89,891
5 |Labs Plus | Sort ? ailer  $33,222
6 |ViaGraphix ailer  $14,155
7 |Compu-Techs +§‘l Add Level || X Delete Level || E[3 Copy Level || & Options... My data has headers :!"Ef $56,666
¢ [Disney - | Column Sort On Order -!“er $76,511
9 |BMW - |Sortby | Distributor or Retaile) v || [Values w| (AtoZ v _butor $23,000
L | |Thenby |state v [wvalues v| |atoz v ] R
11 |Sony ailer  $64,526
12 |Warner Bro. | City v [Values v| |[AtoZ v|| ailer  $53,355
13 |Mckinsey | |Thenby |company w | | Walues v|| |AtoZ v ailer $55,442
14 |Seeley Then by |Revenue Generated |w| |Values v Largestto Smailest | :!"-Ef $72,399
15| Toyota I ailer  $43,232
16 |CB Commercial ailer $44.000
17 [Chrysler | Cancel | butor $23,444
12 INmwr lanae silar SRR ARR

13 ©2016 Dawn Jones and Sherry Prindle All Rights Reserved




Pivot Tables

First | Last | Hire | Department | Job Title | salary | Perf | Mgt |Training| LMS
mana mana
=46000 =3

o - =1/1/1995 _ _ - _ _ _ _ o

First | Last | Hire | Department | Job Title | salary | Perf | Mgt |Training| LMS
Hans Anderson Advanced Filter 2 Office Manager $ 42,000.00 4 2 11 TCR
Jane Fonda Vice President $ 91,000.00 4 1 6 In-House
George  Moore Adion [Vice President | $106,000.00 5 1 27 TCR
Giselle Swan O Bl iTie e, e Dir. of Advertising $ 46,000.00 3 2 9 Start7
Ahmed  Zahn L JEunijivaneibegiosation Web Designer $ 55,000.00 2 2 40 TCR
John Boudreau List range: 5455:5)526 &| Accountant $ 51,000.00 1 4 96 TCR
Marsha  Brady 1 Criteriarange: | pivotisastosa (5| | 1echnical Writer $ 58,000.00 1 5 42 TCR
Anna Buchannan Copyto: =¢| |Accountant $ 43,000.00 4 4 20 TCR
Faith Hill ~  Graphic Designer $ 49,000.00 3 5 4 None
Juan Montoya [] Unique records only Marketing Manager $ 85,000.00 1 3 2 None
Martin Short — Division Manager $ 42.000.00 3 3 60 TCR
Keisha Alexander Payroll Manager $ 41.000.00 5 3 18 In-House

You can take your spreadsheet apart column by column and put it back together
in any configuration you want. Pivot Tables allow you to analyze and recombine

data into reports and charts.

E

Row Labels

= Corporate Mgt
D of Adverlising
Othce Manager
Vice President
Web Designer

= Corporate Staff
Accountant
Dinasion Manager
Graphic Designer
Marketing Manager
Technical Writer

= Managamant Staff
Accountant
General Sales Manager
HR Manager

1. Select one cell within the data
2. Click Insert > Pivot Table > OK

3. Check or drag items in the Field List
to the Row, Filter, Column, or Values
areas

Payroll Manager
- Sales
Product Management
- Section Manager
Circulabion Manager
Dir. of Shipping

Right click Values column headers
to change the operation

Al =10 - g
B I =M.~
By Lopy
[E Fermat Cells...
Murnber Format.
[ Befresh
X Remoge “Sum of Salary

Summarize Values Dy

Sher

PivotTable Options...
B Hide Field List
e
62000
41000

142000

142000

138500
38500
55000

A
T

W

PivotTable Fields it

Choose fiekds to add to report -

First Mame
Last Namre
Hire Date

« Department

| Job Title

7| Salary
Pesl Rating
Mgt Level

Trairmng Haours

Drag fiekls between aress below:

T FILTERS W COLUMNS

= ROWS X VALLES

Departrent = Sumoat Salary  *

Jeb Title

Right click row and column headers to see group options

Explore the Pivot Table

Tools Analyze and Design
ribbons for options such

PIVOTTAELE TOOLS
DATA  REVEW  VIEW  DEVELOPER | ANALYZE | DESIGN 1. Microsoft account -
pSelection | == = [ Clear- [ 7 Fields, Items, & Sets - n = +!
oup FY [?3 [T} Select ~ f OLAP Tools 1 B Q DE‘ E
Insert Inset  Filter | Refresh Change Data i PivotChart Recommended || Field — +/~  Field
p Field Slicer Timeline Connections Source~ | 3 Move PivotTable Relationships PivotTables List Buttons Headers
roup Filter Data Adions Calculations Tools Show
D E F G H I J < }
Sum of Salary Column Labels - PivotTable Fields 3
Row Labels - i 5§ Grand Total - T " o -
= Corporate Mgt 55000 46000 133000 106000 340000 e
Dir. of Advertising S 2 46000 First Name by
Office Manager Eiong ) 42000 Last Name
Vice President Auto 197000 Hire Date
Web Designer 5% W staringat: |1 55000 7 Department
= Corporate Staff 194000 Endingat |5 328000 /| Job Title
Accountant 51000 . 1 94000 /| Salary
Division Manager 42000 /| Perf Rating
Graphic Designer 49000 Mgt Level
Marketing Manager 85000 — 85000 Training Hours -
Technical Writer 58000 58000
= Management Staff 62000 47000 42000 41000 192000 Drag fields between areas below:
Accountant 42000 42000
General Sales Manager 47000 47000 | T FLTES Il CoLUMNS
HR Manager 62000 62000 Perf Rating
Payroll Manager 41000 41000
- Sales 95500 46500 142000 _
Product Management 95500 46500 142000 = Rows 2 RS
= Section Manager 55000 45000 38500 138500 Department v i) Sum of Sabry ¥
Circulation Manager 38500 38500 Job Title M

14
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Adjust Layout




Chapter 4: Top Five Project Management
Challenges Part 1 - Communication

Problems Stemming from Unclear Communication

Write down some of the problems you’ve faced in work and life due to unclear
communication:

4 Learning Methods

Clearly communicate instructions by incorporating all four methods
1. Visual — Pictures, presentations, etc. (fastest way to teach concepts)
2. Verbal — The spoken word (44% need to hear it)

3. Tactile — Hands-on interaction (best way for people to remember)

4. Written — The written word (use bullet points)

Your Preferred Style
What is your preference for receiving and sending communications?

Preferred Sending Style (Rank 1-4) Preferred Receiving Style (Rank 1-4)
Visual Visual

Tactile Tactile

Verbal Verbal

Written Written

The secret to clearly communicating your instructions: Include all four learning
methods.
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How can the Colombo Technique help you confirm your instructions were
understood when you’re communicating with someone who gets defensive when
given instruction?

3 Stages of Learning a New Skill

1. Awkward

2. Mechanical

3. Natural

What does it take to form a new habit?

Remember, Practice makes

Communication and the Triple Constraints

“There’s no reason why my team can’t make this happen within a month.”

Time

Quality

Budget
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Chapter 5: Top Five PM Challenges Part 2 -
Projects, People, and Personalities

Identify and prioritize projects and people by clearly defining project goals and
deliverables. Organize and prioritize the diverse items that interrupt the daily plan
to achieve optimum balance and productivity.

Managing Projects and People: Six Targets to Hit the Project Bullseye

1. Time

2. Quality
3. Budget
4. Skills

5. Behavior
6. Attitude

>>0n Time

>>Best Quality
>>Within Budget
>>Train
>>Counsel/Practice

>Performance Improve

Sample Project: Become a Better Communicator

Questions to ask include: What are my motives? WIIFM: What's In It For Me?
Why should | work on this project? How much time should | allocate for this
project? How will | know I've progressed in my communication? What are some
changes I'll see? How much will this cost?

Sample Goal: Become a better communicator
e Time Frame: 1-year

17

e Quality: Measurable objectives—tangible and intangible

o
o
o
o
o

(0}

Complete a communications course

Join a Toastmasters™ group

Become a better listener

Ask Better Questions

Be more patient

Become more assertive less passive or aggressive
e Budget/Cost

o What will it cost me to do this?
o What will it cost me if | don’t do this?
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Five gquestions to ask yourself when undertaking a project:

1. How / Why
2. When / Why
3. Where / Why
4. Who / Why
5. What / Why

Action: Your Goal

Choose a goal you'd like to accomplish within the next year—professionally or
personally. Write down your goal along then answer the following questions:

MY GOAL:

1. How are you going to accomplish this goal, what are some action steps?

2. What is the cost? What is the financial cost? Emotional cost? Time cost?

3. What is the cost if you don't do it? Financial cost? Emotional cost? Time
cost?

4. When are you doing it? What date? What Time?

5. Where are you doing it?

6. Who is doing this? Who is helping you do this?
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Connecting your projects to people: Measuring People Productivity
o Skills

o0 Behavior

o Attitude

Documenting and confronting poor skill or behavior or bad attitude using
the Respect Most/Improve Upon technique:

Write down three things you respect most about this person in relation to the
project or task at hand.

1.
2.
3.

Write down one thing you'd like them to improve in relation to the project or task.

Action: What do you look like when you're working with people you respect?
What do you look like when you’re working with people you don’t respect?

Documenting Bad Attitude Using the 6-targets and the Respect Most / Improve
Upon technique:




As a project manager, what two things are you looking for from your team
members:

1.
2.

1. Time >>0n Time

2. Quality >>Best Quality

3. Budget >>Within Budget

4. Skills >>Train

5. Behavior >>Counsel/Practice

6. Attitude >Performance Improve

Adapting your personality without coming across as being either weak or
intimidating:

Like traveling to a foreign country, you learn enough of the language to
accomplish your goals and objectives. Write down how you can adapt your
personality style along with your tone, tempo, and body language to speak the
language with a personality that is different than yours:

o Direct/driver style

o Thinker/analyzer style

0 Social extrovert

o0 Relational person




Three stages you’ll go through when developing new and more productive habits:
1. Awkward
2. Mechanical
3. Natural

Action for the Week:

Practice speaking the language of a personality that is different than yours
o Tone
o Tempo

o Body Language

Notes:




Chapter 6: Top Five PM Challenges Part 3 -
Goals, Objectives, Methodology, and Values

People can perform in a project as well as the infrastructure allows. Goals,
objectives, and methodologies are set up on a field of conflicting values. Creating
structure with these challenges in mind allows project managers, team members
and stakeholders to play in a shared arena following agreed-upon rules.

Determine How the Project is Going

1. Meet with the team as a group — Get a fortified explanation of the status
2. Meet individually — Get a better idea of weak links and impacts

State specific objectives

Hear them out

3. Research — Time Sheets, CC Emalils, etc.

Methodology
1. Six Anchor Points — Time, Quality, Budget, Skills, Behavior, Attitude
2. SMART -ER Goals

Specific

Measurable

Agreed-Upon

Realistic

Time Bound

Evaluated

Rewarded
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3. USA Technique (Understand, Situation, Action)
4. Exact Expectations — Get Agreement
5. Respect Most / Improve Upon

6. Communication / Follow-Up with Preferred Method

Values

Our values are a complex combination of our thoughts, emotions, beliefs, and
traditions which help define our morals and ethics and set the standards by which
we work and live. When aspects of a project contradict a person’s values or
people within the project undermine or dismiss the importance of values, the
project suffers.

Action for this week:

List out some times where your values have clashed with the values of a project
or a team member or a stakeholder and how it impacted you and your
contribution to the project:

How did you resolve the issue?

What are some things you would do differently next time?

Notes:




Action for current and future projects:

Implement the tips, techniques, and tools you've learned from this program
including using SMARTER goals.

Utilize and communicate the six stage process for every project by defining,
planning, implementing, completing, evaluating and celebrating while
monitoring and adjusting as you go.

Take the time to accurately rank and prioritize the triple constraints of time,
quality, and budget.

Remember to include the consulting phase of the project to clarify project
goals and the stakeholder(s) expectations.

Employ the project management tools including Excel spreadsheets, Gantt
charts, work breakdown structures, project management software, and
mind mapping then choose the ones that work best for you, your project
and your team.

Deliver your instructions by implementing the four different learning
methods including verbal, visual, tactile, and the written word.

Point people to the six targets of any project by getting them to focus on
and prioritize time, quality, budget, skills, behavior, and attitude.

Adapt and adjust your personality style to those that are different than
yours by being direct or analytical or more extroverted or relational.

Practice the respect most/improve upon technique by naturally and
honestly catching people doing the right things and pointing those things
out prior to pointing out areas that need to be improved or changed.

Regularly meet with your team and the stakeholders to keep them apprised
of project progress or setbacks, as well as individual and team obstacles
and accomplishments.

Remember to be a person of integrity by living your values and respecting
people who believe different than you. Strive to be the same person of
character publically, privately, and secretly.




